
 

Toevoegen en wijzigen objecten in de kaart 

Tot nu toe hebt u met data gewerkt die kant-en-klaar was. Het kan echter zijn dat er data ontbreekt of dat 

data is gewijzigd. In die gevallen moet u zelf geografische data gaan aanmaken door objecten in te tekenen,  

te wijzigen en attribuutgegevens aan te vullen. 

 

In deze oefening gaat u een duingebied intekenen aan de hand van een luchtfoto. U gaat een nieuwe 

wandelroute intekenen met een aantal watertappunten en bankjes. Bovendien gaat u de verschillende 

soorten gebieden intekenen, zoals stuifzand, naaldbos, duinvegetatie en waterpartijen. U maakt hierbij kennis 

met enkele van de mogelijkheden van het Edit tabblad op de ribbon. 

 

De oefening bestaat uit de volgende stappen: 

 

Stap 1: Start ArcGIS Pro en open een bestaand project ............................................................................... 1 

Stap 2: Wandelpaden tekenen ....................................................................................................................... 2 

Stap 3: Banken tekenen ................................................................................................................................. 7 

Stap 4: Areaal tekenen aansluitend tekenen.................................................................................................. 7 

Stap 1: Start ArcGIS Pro en open een bestaand project 

In deze stap gaat u werken in een bestaand ArcGIS Pro project.  

❑ Start eventueel ArcGIS Pro. 

❑ Open het project Editen.aprx (C:\EsriTraining\AP1\Editen).  

Merk op dat er een kaart (Duingebied) aanwezig is met een luchtfoto en verschillende kaartlagen.  

 

In deze opdracht gaan we als eerste wandelpaden intekenen. Een collega van u die al wat ervaring heeft met 

het tekenen is alvast begonnen, zodat u kunt zien wat de bedoeling is. U kunt de wandelpaden herkennen op 

de luchtfoto als gele paden die door de groene vegetatie lopen. 
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In ArcGIS Pro kunt u in principe gelijk beginnen met tekenen. Wanneer u dit niet wilt, is er 

een mogelijkheid om een knop toe te voegen aan het Edit tabblad waarmee u kunt 

aangeven dat u wilt starten met editen en na afloop dat u wilt stoppen.  

Deze knop kunt u toevoegen vanuit de Options (Project > Options > Editing > onderdeel 

Sessions > Enable and disable editing from the Edit tab). 

De Edit knop wordt nu getoond op het Edit tabblad:  (editen staat nu uit) 

Na aanklikken wordt de knop als volgt getoond: . U kunt vanaf dat moment gaan 

tekenen. 

Stap 2: Wandelpaden tekenen 

De wandelpaden zijn in de kaart aanwezig in de lijnen kaartlaag Wandelpad. De wandelpaden die we gaan 

tekenen bevinden zich onderin het Duingebied. 

❑ Open de bookmark Wandelpaden. 

Dit is het gebied waar u de wandelpaden gaat intekenen. 

 

U gaat nu een aantal wandelpaden intekenen in het blauwe deel, zoals hieronder weergegeven.  
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❑ Op het Edit tabblad, klik de Create knop . 

Het Create Features paneel verschijnt standaard aan de rechterkant van het scherm. Hierin staan alle 

kaartlagen uit de huidige map Duingebied met hun symbologie. 

❑ In het Create Features paneel, selecteer de Wandelpad feature template. 

 

 

 

Dit is de kaartlaag waaraan u features gaat toevoegen. Standaard is een recht lijnstuk geselecteerd. 

❑ Selecteer de Line tool . 

 

 

 

Feature templates bevatten alle informatie die nodig is om een object (feature) te maken: de kaartlaag 

waarin de feature opgeslagen wordt, de attributen die het feature kenmerken, de standaard tool 

waarmee de feature wordt getekend. Om templates goed te beheren, helpt het dat u aan templates een 

naam, omschrijving en tags kunt geven. 
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U kunt de Construction Tool Line ook als standaard instellen voor deze feature template. Dit doet u in de 

Properties van de template. (rechtsklik de feature template > Properties) . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

❑ U kunt nu een wandelpad gaan tekenen. Wanneer u de cursor boven de kaart houdt, dan verandert deze 

van vorm in het +-teken. 

❑ Op het Edit tabblad, controleer of de knop Snapping actief is. De knop is omlijnd als deze actief is.   

Indien snapping niet actief is, klik de knop om snapping in te schakelen. 

❑ Klik op het beginpunt van het wandelpad. Wanneer u met de muis in het begin van een reeds getekende 

lijn komt, verschijnt pop-up met een indicatie waar de muis naar toe ‘snapt’. Om deze manier kunt u 

precies op de andere lijn beginnen met tekenen, zonder dat er gaten komen tussen de lijnen. 
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❑ Klik op het tweede punt waar het wandelpad van richting verandert. 

 

 

 

 

De ESC-toets verwijdert de gehele schets die u aan het tekenen bent. Om het laatste 

foutief getekende punt te verwijderen, klik CTRL+Z of de Undo knop  op de Quick 

Access Toolbar.  

❑ Teken nu de rest het wandelpad zoals hieronder aangegeven.  

Om het tekenen te beëindigen, klik F2. 

Het wandelpad is nu nog geselecteerd (default lichtblauw van kleur). 

 

 

U kunt tijdens het tekenen met uw muiswiel inzoomen en pannen om nog nauwkeuriger in te tekenen. 

U kunt tijdens het tekenen ook wijzigen van soort lijnsegment dat u tekent (selecteer in de toolbar die 

verschijnt onderin de kaart, bijvoorbeeld een boog (Arc Segement). 
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❑ Teken vervolgens nog een wandelpad naar keuze in en probeer met behulp van de tekentoolbar te 

wisselen tussen rechte lijnen (de default)   en bogen .  

 

U gaat nu uw wijzigingen opslaan. 

❑ Op het Edit tabblad, klik de knop Save . 

❑ Bewaar uw edits door Yes te klikken. 

 

❑ Uw edits zijn nu opgeslagen in de featureklasse Wandelpad.  

 

 

TIPS voor het herstellen van fouten 

Het aanpassen van de sketch: 

Een foute vertex (tussenpunt) is te verwijderen door er met de muiscursor precies op te gaan staan en 

rechtsklik >  Delete Vertex te kiezen. 

Een vertex is te verplaatsen door de muiscursor er even boven te houden totdat de cursor van vorm 

verandert in  en hem dan te verslepen. 

 

Het aanpassen van een al voltooid feature: 

Van een al voltooid feature kunt u eenvoudig weer een sketch maken  

door deze te klikken met de Select  tool. Kies vervolgens Modify  

en kies hier voor bijvoorbeeld Reshape > Vertices. 

 

Het verwijderen van fout getekende vertices: 

Mocht u - per ongeluk - een sketch zijn begonnen maar wilt u  

deze niet afronden dan kunt u met de Escape toets de sketch  

verwijderen. 

 

Het verwijderen van fout getekende objecten: 

Indien een object is getekend, maar u wilt deze alsnog verwijderen,  

selecteer het object dan met de Select  tool en klik vervolgens  

op de Delete  knop of de Delete knop op het toetsenbord. 
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Stap 3: Banken tekenen 

In de vorige stap heeft u een lijnen featureklasse ingetekend. In deze stap gaat u een punten featureklasse 

intekenen. 

❑ In het Feature Templates paneel, selecteer Bank. 

 

 

❑ Rechtsklik op een willekeurige plek in de kaart. 

Een contextmenu verschijnt. 

❑ Selecteer Absolute X,Y,Z. 

❑ Vul de volgende waardes in: 

X: 80,555 

Y: 459,745 

Z: 0 

❑ Klik ENTER. 

De bank wordt geplaatst op de ingevoerde x,y-locatie. Indien u de bank niet ziet, zet de luchtfoto uit en 

zoom iets uit. 

❑ Teken een aantal andere banken in langs de getekende wandelpaden door op de gewenste plek te 

klikken. 

Stap 4: Areaal tekenen aansluitend tekenen  

In deze stap gaan we een aantal arealen (polygonen of vlakken) intekenen voor een deel van het duingebied. 

We geven hierbij aan wat voor soort begroeiing er grotendeels op de locaties te vinden is. De naam van deze 

vlakken kaartlaag is Areaalbeheer. Wandelpaden en puntobjecten mogen elkaar overlappen. Arealen mogen 

elkaar niet overlappen. 

❑ Open de bookmark Arealen. 

U ziet dat een aantal gebieden al is ingetekend.De kaartlaag Areaalbeheer is transparant gezet, om de 

onderliggende luchtfoto nog goed te zien. 

 

Om het nieuwe vlak exact te laten aansluiten op dit bestaande gebied gaat u eerst controleren of Snapping 

correct is ingesteld. 

De snapping-instellingen vindt u in ArcGIS Pro in de linkeronderhoek van het kaart tabblad (hier Duingebied 

genaamd): 
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De Snapping knop is ook te vinden op het Edit tabblad van de ribbon. 

❑ Klik de Snapping knop  om snapping aan  of uit   te zetten. 

 

 

Er verschijnt nu ook meteen een pop-up met de snapping instellingen. Point, End, Vertex en Edge (rand) 

snapping staan standaard aan. Intersection, midpoint, en tangent snapping kunnen optioneel worden 

aangezet. 

❑ Zorg dat alleen Vertex snapping en Edge snapping actief zijn. 

 

 

❑ Controleer meteen of de XY Tolerance (onder Snapping Settings) op 10 pixels staat. De snapping 

tolerantie is de afstand waarbinnen de muisaanwijzer of een feature ‘snapt’ (wordt toegetrokken) naar een 

andere locatie.  

U gaat nu als eerste een duinvegetatie vlak (zie het geselecteerde vlak in de afbeelding hieronder) intekenen. 

Dit gebied sluit aan de onderkant aan op een al bestaand duinvegetatievlak, zie de afbeelding hieronder. 

 

 

❑ In het Create Features paneel, selecteer de Duinvegetatie template. 
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Merk op dat de Polygon Tool actief is. De standaard tool is voor elke feature template afzonderlijk in te 

stellen. 

 

Merk op dat, zodra u in de buurt komt van een al bestaand landgebruiksvlak in de kaartlaag Areaalbeheer, 

de cursor naar de grens van dit vlak toe ‘springt’. Probeer de vorm van het duingebied met zo min mogelijk 

punten (vertices) vorm te geven. 

 

 

 

 

 

 

Merk op dat het getekende vlak meteen wordt weergeven in de kleur van het duinvegetatie. 
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❑ Sluit het vlak af met rechtsklik > Finish of met F2. 

U kunt ook afsluiten door te dubbelklikken maar u moet dan wel oppassen dat u niet per ongelijk twee 

vertices plaatst. 

 

 

 

Het getekende vlak wordt nu weergeven in de lichtblauwe selectiekleur. De vertices worden niet meer 

getoond. Het is nu een feature, en niet langer een sketch.  
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Het tweede gebied dat u gaat tekenen betreft een Stuifzandgebied. Dit grenst aan ingetekende vlakken. Om 

de bestaande grens niet opnieuw te hoeven tekenen zullen we hiervoor gebruik maken van een andere 

Construction Tool: Auto-Complete Polygon. Met deze tool hoeft u alleen de ontbrekende lijn te tekenen. 

Zodra deze lijn, samen met de bestaande features, een volledig omsloten gebied vormt, wordt het nieuwe 

vlak automatisch gecreëerd. 

❑ In het Feature Templates paneel, selecteer de template Areaalbeheer > Stuifzand. 

❑ Als tekentool, selecteer Autocomplete Polygon. Dit is niet de standaard tool, dus u moet deze zelf 

kiezen. 

 

  

❑ Teken van het Stuifzandgebied alleen die grenzen die NIET samenvallen met de reeds bestaande 

vlakken.  

Begin links bovenin. 

 

 

❑ Klik als laatste punt op een vertex van het Areaalbeheervlak dat het andere Stuifzandgebied weergeeft. 
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❑ Klik F2 om het tekenen te beëindigen. 

U zult merken dat het vlak wordt ‘opgevuld’ tot de randen van de reeds bestaande vlakken, zonder dat u 

deze lijnen heeft hoeven overtrekken. 

 

 

 

De twee vlakken die u zojuist heeft getekend worden weergegeven met de symbologie van de gekozen 

feature template. Dat wil zeggen dat de attribuutwaarde voor het veld Soort begroeiing reeds is ingevuld 

met resp. Duinvegetatie en Stuifzand is. 
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Wanneer u een fout heeft gemaakt en het in feite bijvoorbeeld Naaldbos moet zijn, dan moet u de 

attribuutwaarde wijzigen. De kleur van de symbologie zal automatisch worden aangepast. 

 

Om de omschrijving voor het Duinvegetatievlak te wijzigen: 

❑ Selecteer het zojuist getekende Duinvegetatievlak met de  Select Tool. 

❑ Op het Edit tabblad, klik op de Attributes knop  om het Attributes paneel te openen.  

 

 

U ziet nu als het ware één rij (record) uit de attribuuttabel van de kaartlaag Areaalbeheer. Bij de Soort 

begroeiing van dit gebied staat de waarde Duinvegetatie.  

❑ Klik met de muis éénmaal op de waarde Duinvegetatie, het invulveld wordt actief. Uit de uitklaplijst met 

mogelijke waarden, selecteer Naaldbos en klik Apply. 

 

 

U zult zien dat het vlak in de kaart nu ook meteen met de juiste kleur wordt weergegeven, hiervoor wordt 

namelijk het zojuist ingevulde veld Soort begroeiing in de attribuuttabel gebruikt. 
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❑ Wijzig de waarde weer terug in Duinvegetatie en sluit het Attributes paneel. 

❑ Sla uw wijzigingen op door te klikken op de Save knop  op het Editor tabblad.  

 

 

Het is belangrijk om tijdens een edit-sessie regelmatig uw veranderingen op te slaan om onverhoeds 

verlies van uw wijzigingen te voorkomen! ArcGIS Pro biedt een auto-save optie die u hierop kan 

attenderen. U stelt dit in onder Project > Options > Editing > Session: 

 

 

 

 

 

 

 

Vanaf nu verschijnt er om de 10 minuten een herinnering om uw edits op te slaan: 

 

 

 

 

. 

 

Als volgende tekent u naaldbos in bovenin het gebied (zie de afbeelding hieronder). Ook hiervoor gebruikt u 

weer de Auto Complete Polygon tool zodat u netjes aansluitend tekent. 
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❑ Selecteer de template Naaldbos. 

❑ Selecteer de Auto Complete Polygon tool. 

❑ Teken vervolgens op eenzelfde wijze als het vorige vlak het betreffende naaldbos. 

❑ Als laatste van de reguliere opdracht tekent u een watervlak in (gebruik de template Open Water en 

gebruik weer de Autocomplete Polygon). 
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Uw eindresultaat ziet er ongeveer uit als in de onderstaande afbeelding: 

 

❑ Sla uw wijzigingen op door te klikken op de Save knop  op het Editor tabblad. 

❑ Laat ArcGIS Pro open voor de volgende oefening waarin u attribuutgegevens gaat toevoegen en wijzigen. 

 

 


